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Abstract 

31	

A major endeavour of systems biology is the construction of graphical and computational models of 

32	

biological pathways as a means to better understand their structure and function. Here, we present a 

33	

protocol for a biologist-friendly graphical modelling scheme which facilitates the construction of detailed 

34	

network diagrams, summarising the components of a biological pathway (such as proteins, biochemicals 

35	

etc.) and how they interact. These diagrams can then be used to simulate activity flow through a pathway, 

36	

thereby modelling its dynamic behaviour. The protocol is divided into four sections: 1) Assembly of network 

37	

diagrams using the modified Edinburgh Pathway Notation (mEPN) scheme and yEd network editing 

38	

software using pathway information obtained from published literature and databases of molecular 

39	

interaction data, 2) parameterisation of the pathway model within yEd through the placement of ‘tokens’ 

40	

based on the known or imputed amount or activity of a component, 3) model testing through visualization 

41	

and quantitative analysis of the movement of tokens through the pathway using network analysis tool 

42	

BioLayout Express3D, 4) optimisation of model parameterisation and experimentation. This is the first 

43	

modelling approach that combines a sophisticated notation scheme for depicting biological events at the 

44	

molecular level, with a Petri net-based flow simulation algorithm and powerful visualisation engine with 

45	

which to observe the dynamics of the system being modelled. Unlike many mathematical approaches to 

46	

modelling pathways, it does not require the construction of a series of equations or rate constants for model 

47	

parametrisation. Depending on a model’s complexity and the availability of information, its construction can 

48	

take days to months, and, with refinement, possibly years. However, once assembled and parameterised, 

49	

a simulation run, even on a large model, typically takes only seconds. Models constructed using this 

50	

approach provide a means of knowledge management, information exchange, and through the computation 

simulation of their dynamic activity, a means to generate and test hypotheses, and predict a system’s 

behaviour when perturbed. 



3	

51	

52	

53	

Introduction54	

The era of molecular biology has resulted in the generation of vast amounts of data on biological processes, 55	

ranging from in-depth studies of one or two molecules and their interactions, to large sets of omics data. 56	

These data are currently scattered in the literature and databases and difficult to connect together. Those 57	

trying to learn about a particular biological process or pathway often start by studying the primary literature 58	

and reviews. However, relying only on the medium of the written word it can often be a struggle to 59	

understand the available knowledge as a series of interconnected events. The task is made more difficult 60	

as the literature often refers to the same pathway component by different names, which may not or not be 61	

their official names (as dictated by nomenclature committees). Representation of biological systems as 62	

graphical models, i.e. diagrams, can in principle circumvent these issues by presenting a system in a 63	

visually intuitive manner using a standardized notation scheme to represent pathway components and the 64	

interactions between them. One of the ultimate goals of a pathway model is the ability to use it for 65	

computational simulations, thereby supporting hypothesis generation and experimental design. Use of a 66	

system that fulfils these criteria could benefit any scientist working in experimental biology. 67	

68	

We have developed a modelling platform that combines elements of other approaches1. The modified 69	

Edinburgh Pathway Notation (mEPN) scheme was first published in 20082, refined in 20103, and is 70	

presented here in its current form (BOX 1).  Representing the interactions between biological components 71	

in the context of a pathway diagram is a challenge, and a number of notation schemes have been 72	

proposed3-9. In an effort to standardise pathway diagrams, the Systems Biology Graphical Notation (SBGN) 73	

community proposed standards for pathway depiction, including the process description (PD) language7 74	

based on ideas first proposed by Kitano et al.4. In SBGN-PD diagrams (and in the modelling approach 75	

described here), components of a pathway are depicted using a standard set of shapes (glyphs), and both 76	

the nature of the interactions between components and the products of those interactions must be shown 77	
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explicitly. Pathway models are constructed where entity nodes represent molecular components, process 78	

nodes represent the different types of interactions that can occur between the components, and edges link 79	

entity and process nodes. Since PDs were first described various models have been constructed based on 80	

this approach2,10-15 and there is a growing number of software tools that support model creation (using 81	

SBGN-compliant languages), e.g., CellDesigner16,17, NaviCell11, KEGG Mapper18, ReactomeFiViz19, iPath20 82	

and SBGN-Ed21. There are also a number of centralised databases providing pathway resources of this 83	

type22-25. The mEPN scheme used here to model pathway systems is similar to the SBGN ‘process 84	

description language’ but with important differences in how both components and events are represented. 85	

In particular, mEPN supports the representation of wider variety of biological components and processes, 86	

simplifies the depiction of complexes, promotes the use of standard nomenclature, and importantly, 87	

diagrams can be used directly for the computational modelling of system dynamics (for a more complete 88	

description of mEPN and comparison to the SBGN-PD language, see O’Hara 20161). mEPN pathway 89	

models can be drawn using the free graph editing software yEd (yWorks, Tübingen, Germany; 90	

www.yworks.com), and since the notation scheme was first described	 2,3	has been formalised so as to 91	

support the use of models for pathway activity simulations1.  92	

Numerous mathematical approaches exist to simulate system dynamics including ordinary and partial 93	

differential equations, qualitative differential equations and stochastic equations. The Systems Biology 94	

Markup Language (SBML) has been developed as an open interchange format for such mathematical 95	

models26 and the SBML site also has an extensive list of existing tools and resources supporting pathway 96	

modelling primarily by equation-based approaches 97	

(http://sbml.org/SBML_Software_Guide/SBML_Software_Summary). Most mathematical models require 98	

experimentally derived rate constants to feed into equations and significant computational power to solve 99	

a series of equations. This generally limits equation-based approaches to modelling relatively small and 100	

well characterised systems. Moreover, the level of mathematics skills required to construct and run these 101	

models is often a deterrent to adoption by biologists. The platform described here uses Petri nets, as the 102	

basis for pathway activity simulations. The primary resource for Petri net modelling is a network diagram 103	

consisting of nodes, called ‘places’, and other nodes representing the interactions between them, called 104	

‘transitions’, to which the user need only add ‘tokens’, that represent the amount or activity of a place prior 105	
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to performing a simulation (for more details of Petri nets see BOX 2). There is a long and established 106	

precedent for the use of Petri nets in the modelling of biological pathways	 27-33 and several tools and 107	

algorithms are available that allow the user to construct models based on Petri nets 34-36. The Petri net 108	

algorithm employed here was first described by Ruths et al.37 who named their approach the signalling Petri 109	

net simulator (SPN). It combines elements of a Boolean network simulator38 with a synchronized Petri net 110	

model39, and models the stochastic flow of tokens through a network. A great advantage of Petri nets is the 111	

relative ease of model parameterisation, the scale to which models can be constructed, the computational 112	

speed of simulations, as well as the fact that the user does not need to directly modify the maths when 113	

experimenting. The downside to most of the tools that currently support pathway modelling using Petri nets 114	

is the inability to represent pathway models in anything but the standard Petri net notation (open circles and 115	

black rectangles), and limited options for the visualization of results. Here, we describe how a pathway 116	

model drawn according to the rules of mEPN, can then be parameterised for computational modelling by 117	

the addition of tokens, whose quantity can be based on experimental results such as quantitative 118	

transcriptomics or proteomics data. When a mEPN model is imported into the open-source software 119	

BioLayout Express3D	40	 it is visualised in a 3D environment, with nodes now represented as 3D shapes. 120	

Simulations can subsequently be performed that calculate the flow of tokens through the pathway over 121	

time. Pathway activity can then be visualised as plots or animations, where token accumulation is 122	

represented by the size and colour of an entity node (Supplementary Video 1). Altering the simulation 123	

parameters can change the flow of tokens, allowing the dynamics of pathways to be modelled under 124	

different conditions. The modelling approach described in this protocol can be applied to model any system, 125	

large or small, biological or otherwise, that consists of a series of components that interact in a predefined 126	

manner. In the case of biological pathways, the mEPN notation scheme allows for the detailed 127	

representation of signalling cascades, metabolic pathways, transcriptional networks, as well as 128	

feedback/feedforward loops. To date, we have used this approach to model a wide variety of biological 129	

pathways, particularly associated with immune signalling, e.g., Toll-like receptors (TLR), NF-kB, 130	

complement activation and antigen presentation, but also biochemical pathways e.g. cholesterol 131	

metabolism, TCA cycle, and even pathways spanning multiple organ systems e.g. glucocorticoid, 132	

oxytocin/prolactin signalling (see: www.virtuallyimmune.org and O’Hara et al.1 for examples). Many of these 133	
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models were built as graphical representations of events as described in the literature and as such act as 134	

a graphical bibliography, with pathway components or processes hyperlinked to research papers or reports. 135	

However, with additional work they can also be used as the basis for performing simulation experiments. 136	

These simulations not only test the logic of what is depicted, but also predict the behaviour of the system 137	

and its response to perturbation. Using this approach models can be assembled at scale, representing tens 138	

or thousands of components and the interactions between them. The overall aim of the modelling approach 139	

described here is to, provide a platform for the assembly of information on a particular system into an 140	

informative diagram, to allow the use of the diagram explore how the system might operate, and through 141	

experimentation, make testable predictions 41 42. 142	

The protocol provided here complements the paper published recently by O’Hara et al.1, which describes 143	

the development of and underlying concepts associated with this approach. This modelling platform may 144	

not be appropriate in situations where many of the interactions between components are not known due to 145	

the requirement to define both components and interactions, or where there is need to use specific rate 146	

parameters to regulate the dynamics of a system, as the approach does not allow for the integration of rate 147	

constants for specific reactions. Other limitations of Petri net-based approaches are the requirement that 148	

all tokens and transitions behave the same way. In other words how a protein binding event is modelled, is 149	

the same as how an enzymatically catalysed biochemical reaction would be modelled, where outputs are 150	

determined by the number of tokens on the reactants. This is not likely to be an issue for many applications, 151	

but could limit the approach’s applicability in certain circumstances requiring a more complicated concepts 152	

to be built within the model. 153	

 154	

Experiment Design 155	

First we describe how to construct a graphical model of a biological pathway using the mEPN scheme 156	

(steps 1-8). We then explain how to convert this purely graphical representation into a resource that 157	

supports computational modelling of the system (steps 9-11). Next, we present how to test the dynamic 158	

properties of the model through running simulations and visualizing results (steps 12-20), and in the final 159	
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section (steps 21-25), describe how to optimise and validate the pathway model. The workflow is shown 160	

schematically in Figure 1. To illustrate our approach, we use a model of interferon-β signalling. The model 161	

is small and simple, but encompasses many of the basic concepts associated with pathway construction 162	

and motifs such as a negative feedback loop, a common feature of many biological systems 43. However, 163	

we encourage the examination of other larger models we have constructed, covering a range of biological 164	

systems, in order to appreciate the scale and complexity models can achieve (examples can be found at 165	

www.virtuallyimmune.com). Before embarking on model construction, users should search the literature 166	

and pathway databases, such as those listed in Table 1, for existing diagrams of their system of interest. 167	

Careful consideration should be given to the initial scope of the model, the level of detail to be represented 168	

and what the model is to be used for once constructed. For instance, given the interconnectivity of biological 169	

pathways, it is easy to begin with the aim of modelling one thing and end up spending a lot of time modelling 170	

something entirely different, because it is one way or another related to the first. Having said this, models 171	

will inevitably evolve as information is gathered and assimilated, and the journey taken is part of the reward 172	

of modelling. 173	

 174	

Materials  175	

Equipment  176	

A computer with Windows, Apple Mac or Linux operating system (preferably 64-bit), internet connection 177	

and a web browser with JavaScript enabled. The hardware configuration may limit the size of models that 178	

can be displayed within yEd, as well as when running pathway simulations within BioLayout Express3D, 179	

where it will influence the speed of simulations and the frame rate for animations of flow. We recommended 180	

>4Gb main RAM, a Dual-core CPU, NVidia GeForce / Quadro series or ATI equivalent graphics card for 181	

advanced visualization with GLSL Shaders, preferably two monitors capable of displaying at 1,600 x 1,200 182	

resolution and a three-button mouse to aid navigation.  183	

 184	
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Equipment setup 185	

Installation of yEd Graph editor 186	

yEd is a free and intuitive software application that can be used to create high-quality network diagrams, it 187	

runs on all major platforms: Windows, Unix/Linux and Mac OS X. Download and install the latest release 188	

of the yEd Graph editor from the yWorks (Tübingen, Germany) website www.yworks.com. yEd will use up 189	

approximately 215 MB of hard disk space. If you encounter any problems with the installation of yEd contact: 190	

support@yworks.com  191	

Loading the mEPN palette 192	

Download the GraphML (.graphml) file containing the mEPN glyphs (Supplementary Data 1) and load it 193	

into yEd by selecting Edit → Manage Palette → Import Section. This will provide the standard palette of 194	

mEPN glyphs that can be selected as required when constructing a pathway model. To display the mEPN 195	

symbols palette select from the menu bar Windows → Palette. Alternatively, create each node type afresh 196	

by adding a node and changing its visual properties [F6]. As an example, see the list of components present 197	

in the interferon-β pathway (Figure 2A). 198	

Installation of BioLayout Express3D 199	

BioLayout Express3D software allows the visualization and analysis of large network graphs in two and 200	

three-dimensional space and supports the computational modelling of networks using the signalling Petri 201	

net (SPN) algorithm37. BioLayout Express3D runs on Windows, Mac OS X and Linux platforms. Java SE 6 202	

or 7 is required and can be downloaded from http://www.java.com/getjava. BioLayout will use up 203	

approximately 41 MB of hard disk space. To download the BioLayout Express3D installer, navigate to 204	

http://www.biolayout.org/download/ and download an installer for Windows (.exe) or Mac OS X (.dmg). For 205	

Linux platform use the universal JAR file that may be run without an installer. When BioLayout Express3D 206	

runs for the first time it creates a preferences file that can be changed and saved at any time from the menu 207	

option Tools → Save Preferences. Users can customize many options selecting from the menu bar Tools 208	

→ General Properties (Shift+P). Further details on the software interface and its customization are available 209	
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in the BioLayout Express3D manual that can be downloaded from the tools support pages. If you encounter 210	

any problems with the installation of BioLayout Express3D contact: support@biolayout.org  211	

 212	

Procedure  213	

Pathway model construction (timing: hours to months depending on complexity 214	

of model)  215	

1. Source information for pathway construction. A pathway model should aim to provide a 216	

comprehensive and reliable view of the current state of knowledge about the system. To 217	

achieve this collect and extract the relevant information about the pathway from the literature, 218	

databases and existing diagrams. Possible sources to consult are presented in Table 1. A 219	

comprehensive list of databases for data mining can be found at www.pathguide.org. For some 220	

pathways, data are available from multiple species and/or cellular systems, therefore users 221	

must decide whether to piece together information from heterogeneous sources or to restrict 222	

their model to reflect a particular species, cell type or developmental stage. To keep track of 223	

the data, create a spreadsheet that includes: molecular identifiers, e.g. HUGO, Entrez IDs, 224	

details about nature of the molecular interactions, sources of information, e.g. PubMed ID, the 225	

quality of evidence (as assessed by number of publications supporting a given interaction and 226	

the reliability of the assays used) and any additional information that may be relevant.  227	

!Troubleshooting 228	

 229	

 230	

2. Identify the types of pathway information. Divide details of the pathway of interest into the 231	

categories defined the mEPN notation scheme (see BOX 1). Find the ‘real’ name of pathway 232	

components. The use of standard gene/protein names is essential in defining the exact identity 233	

of components, especially if models are to be used in the interpretation of omics data where 234	
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the use of standardised nomenclature systems is standard practice (see BOX 3). Record and 235	

characterise the type of interaction between components. 236	

 237	

3. Commence drawing - addition of entity nodes. Molecular components are represented using 238	

entity nodes. To add an entity node to the diagram, select and drag the appropriate glyph from 239	

the mEPN palette (BOX 1).  Edit a node’s properties by selecting it and pressing [F6]. The node 240	

Properties dialogue will appear. Add the component’s name to the General tab, where 241	

necessary changing the size of the node to fit the label, record the reference source or insert 242	

a brief description about a given component in the Data tab. Also add a hyperlink to an external 243	

site (for example NCBI’s Gene database), which can then be activated by selecting the node 244	

and pressing [F8]. A description of the component, if available, will be shown in a pop-up 245	

window when the mouse is placed over the node in yEd.  246	

 247	

4. Draw the interactions between entity nodes. The nature of an interaction between components 248	

may be represented using a combination of process nodes and edges. To add a process node 249	

to the diagram, select and drag the appropriate glyph from the mEPN palette (BOX 1). As with 250	

components (entity nodes) additional information may be added to the process node by 251	

selecting it and opening the Properties dialogue [F6]. Pathway modules are a special type of 252	

process node. They represent multi-reaction processes or events and are represented using 253	

octagons with a label identifying the name of the process they represent. They might be used 254	

to represent such pathway as signalling cascades, endocytosis, compartment fusion, etc. 255	

Edges are lines that join entity and process nodes. Edges denote the type of interaction 256	

(activation, catalysis, inhibition) and their directionality establishes inputs and outputs from 257	

entity/process nodes. To add an edge, click on a node using left mouse button and keep held 258	

down, then drag the mouse to move the edge to the target node and release. If you release the 259	

mouse button on the way to the target node, a pivot point will be introduced. To change the 260	

appearance of an edge (colour, thickness, arrow type or to add text/hyperlink), select the edge 261	

by clicking on it and open the edge properties dialogue [F6]. The sample 262	
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Interferon_components.graphml file can be used to try out the procedures described in this 263	

step (Supplementary Data 2). Note: yED supports the import of data in Excel or .CSV files in 264	

a variety of formats (see http://yed.yworks.com/support/ for details). This functionality may help 265	

initially in defining a set of pathway components and the interactions between them, prior to 266	

manual editing of node/edge properties and layout. 267	

CRITICAL STEP. In general (and absolutely so when constructing a diagram to be used for 268	

computational modelling), nodes comprising a pathway should be arranged as a bipartite graph 269	

i.e. entity nodes should be connected exclusively to a process nodes and vice versa. This 270	

structure is the same structure used by Petri nets (places must be connected to transitions) 271	

and it is essential if the model is to be used for simulation experiments. 272	

 273	

5. Add compartments. Components should be represented as existing within a given cellular 274	

compartment. Drag the desired compartment node from the mEPN palette and enlarge it to 275	

cover the section of the pathway diagram which represents a given cellular compartment such 276	

as the plasma membrane, cytoplasm or nucleus. Move the selected compartment behind the 277	

diagram by choosing Edit → Lower selection. Name the compartment, placing the name 278	

between asterisks (*compartment name*). The asterisks inform the BioLayout Express3D 279	

parser to treat these nodes differently: they are displayed as a translucent background to the 280	

pathway and cannot be selected within this tool. If they are labelled as follows *compartment*N* 281	

where *N* is a numerical value, e.g. 100, when viewed in BioLayout the compartment becomes 282	

a 3D container where the N value determines its depth (Z-value). The decision on a 283	

compartment’s ‘depth’ is based on purely on final aesthetics as compartments do not effect 284	

model dynamics.  Generally the cell membrane would be the largest component and its internal 285	

organelles are smaller compartments that sit within it, but other than this the values given are 286	

subjective. Suggested cellular compartment colours are defined in the mEPN palette. 287	

Generally, when compiling a model it is best to add compartment nodes at the end or at least 288	
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put them to one side when editing, as they tend to get in the way. The completed pathway 289	

should look similar to the interferon-β pathway example in Figure 2B. 290	

 291	

6. (Optional) Add negative feedback loops. Feedback loops are network motifs common to many 292	

systems and involve the activation of a pathway component that goes on to inhibit an earlier 293	

step in the process. The inhibition of the interferon-β receptor by SOCS1 whose transcription 294	

is activated by the interferon signalling pathway represents such a negative feedback loop 295	

(Figure 2B). To represent an inhibitory activity such as this using the mEPN scheme, place an 296	

inhibitor edge from the inhibitor molecule to a process node representing the step that is 297	

inhibited.  298	

 299	
7. Optimise model layout. It is essential that a pathway model is compact and easy to follow i.e. 300	

be readable by a human. How this is best achieved will be influenced by a model’s size and 301	

complexity. First organise the pathway components based on where they reside within the cell, 302	

i.e. their cellular compartment. Then attempt to separate out ‘modules’ based on connectivity 303	

amongst a group of nodes, e.g. a particular signalling cascade or other series of events. This 304	

helps with a model’s readability and facilitates model expansion as new data becomes 305	

available. Further information on layout optimisation can be found in BOX 4. In practice, model 306	

optimisation is normally an iterative and time consuming process often requiring a degree of 307	

trial and error in how best to layout the diagram. When in the dynamic modelling phase it may 308	

for example be necessary to add in motifs that in effect delay the passage of tokens from place 309	

to another in order, to model processes that are not explicitly shown but may influence the 310	

order or timing of an event. 311	

 312	

8. Save and export the pathway models. The pathway model should now represent a 313	

diagrammatic version of known events and should be saved in the GraphML file format 314	

choosing File → Save. Within yEd a model can also be exported as an image in PNG or JPG 315	

format, as PDF or as HTML by selecting File → Export and selecting the preferred format.  316	

 317	
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Model testing - conversion of a graphical model into a computation model 318	

(timing: minutes to hours) 319	

9. Set the initial parameters. To convert a graphical representation of a pathway into a 320	

computational model, you must define the initial state of the system through a process of 321	

‘parameterisation’. To parametrise the assembled model, add defined numbers of tokens to 322	

entity nodes at the beginning of network i.e. nodes that have no ‘parents’ (upstream 323	

connections). To define the initial state of a component, place an input node (depicted as a 324	

black rectangle which functions as a transition node) upstream of the component to be 325	

parameterised and connect it with a standard edge. Define the number of tokens to be added 326	

to the node by selecting the edge between an input node and component. Open the edge 327	

properties dialogue [F6] and type the desired number of tokens into the edge name (text) 328	

(Figure 2C). Token values can in theory range from 0 to millions but in essence represent the 329	

relative amount or activity of a given component under initial conditions. Ideally, the initial 330	

parameters should be set with reference to some experimental data providing information on 331	

the relative initial concentrations of the pathway components where known. However, in the 332	

initial stages of pathway parameterisation and model testing, it is often sufficient to place an 333	

arbitrary number of tokens on components, e.g. 1000, just to check the connectivity between 334	

inputs and outputs is not compromised in any way.  335	

 336	

10. Defining inhibitory reactions. An inhibitor edge originates from an inhibitory molecule and 337	

terminates at the process to be inhibited, tokens present on the inhibitor node preventing token 338	

flow through the process node. During a simulation tokens will not be lost through an inhibitor 339	

edge and therefore tokens accumulate on an inhibitor node and irrevocably block the process 340	

to which it is connected. However, if a sink node is connected to the inhibitor it serves to give 341	

the inhibitory molecule a ‘half-life’ (in practice any process node will serve the same purpose, 342	

but use of the sink node helps visually define the process involved). In the absence of further 343	

input into the inhibitor node, such as during the ‘off phase’ of negative feedback system, tokens 344	
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will now be lost from the inhibitor. The result is that its inhibitory effect will lessen and the 345	

blocked transition will eventually open and tokens may flow again through it. In presence of a 346	

constant input this can cause token flow in negative feedback systems to oscillate. There are 347	

two types of inhibitor edge included in the notation scheme that perform differently in the 348	

modelling environment; the non-competitive inhibitor edge (red with perpendicular bar at end) 349	

and a competitive inhibition edge (red with open diamond end). The non-competitive inhibitor 350	

edge completely blocks token flow through the target transmission if any tokens are present on 351	

the inhibitor node. In contrast the competitive inhibitor edge works by deducting the number of 352	

tokens residing on the inhibitor away from the number of tokens flowing through the target 353	

transition. The behaviour of negative feedback systems is not only dependent on the type of 354	

inhibitor edge used but also the distance between the input of tokens and the inhibitory step. 355	

The greater the distance the more tokens are able to accumulate in the system and the greater 356	

the time taken between the opening and closing of the inhibited transition, i.e., the longer the 357	

wavelength and the higher the amplitude of the oscillating signal. Other factors that can affect 358	

the oscillatory behaviour of the feedback loop are the number of inhibitors acting on the 359	

pathway and assumptions about the stochasticity of token flow. 360	

	361	

11. Save the parameterised model in the GraphML file format choosing File → Save. GraphML 362	

files can be loaded directly into BioLayout Express3D. A parser within the tool translates the 363	

mEPN nodes into their 3D equivalent shapes such that they can now be visualised within the 364	

tool’s 3D environment. It also differentiates between nodes in the diagram that act as Petri net 365	

‘places’ and that are ‘transitions’, and reads the parameterisation markings that define initial 366	

token inputs. BioLayout Express3D is also able to perform stochastic flow simulations using a 367	

modified version of the signalling Petri net algorithm37. A file containing simple Petri net models 368	

of all primary motifs found in pathways is provided as a means to better understand the flow 369	

characteristics of this algorithm (Supplementary Data 3). 370	

 371	
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Running simulations using BioLayout Express3D (timing: 5-15 min) 372	

12. Load the saved GraphML file into BioLayout Express3D. Supplementary file 4 is the 373	

interferon-β pathway model shown in Figure 3C and as such is ‘simulation ready’. Following 374	

opening of the file answer yes to the dialogue window “This looks like a Signalling Petri Net 375	

(SPN) pathway. Would you like to run a SPN simulation now?” (Figure 3A). This opens the 376	

SPN simulation dialogue (Figure 3B). The dialogue can also be selected from the main menu 377	

under the Simulation menu or by pressing the “RUN SPN” button on the sidebar. 378	

!Troubleshooting 379	

 380	

13. Set the SPN simulation options. Choose the number of time blocks and the number of runs. 381	

A ‘time block’ is when all transitions are fired exactly once in a random order and tokens 382	

moved as a result. A series of time blocks is referred to as a ‘run’, the more time blocks the 383	

longer the run (Figure 3B1). The bigger the model or the more conditions you want to test 384	

within a simulation, the more time blocks you will require for a simulation. It is good practice 385	

to check the nodes furthest away from token input points to ensure that token accumulation 386	

has plateaued or in the case of negative feedback circuits, that enough time blocks have been 387	

run to evaluate the oscillatory behaviour of the system. The Petri net algorithm employed here 388	

is stochastic in nature. That is to say that the number of tokens passed on, when a transition 389	

is ‘fired’ is variable depending on the algorithms stochastic setting (see below), and 390	

furthermore the order in which transitions are fired is random. Therefore, the result of 391	

individual runs can be highly variable. For this reason a simulation is generally comprised of 392	

multiple runs, where the outcomes from individual runs are averaged to calculate the mean 393	

number of tokens present on a given node at each time block (Figure 3B2). The more runs 394	

used the less variable the results between simulations, but the more time it will take to perform 395	

a simulation. To visualise the variation associated with a given simulation check the ‘Calculate 396	

Variance’ and pick either standard deviation or standard error (Figure 3B3).  397	

 398	
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14. Select the token stochasticity setting. The possible modes for token flow can be selected as 399	

shown in (Figure 3B4) and are described below:  400	

 401	
Uniform Distribution: Each time a transition is fired, an entirely random number of tokens 402	

between zero and the maximum number of tokens are moved from an input place to the 403	

output place (assuming there no other inputs on the transition which may influence flow). 404	

This mode is as originally described by Ruths et al.37 in their description of the SPN 405	

algorithm. 406	

Standard Normal: Each time a transition is fired, the number of tokens moved between 407	

input and end places will be randomly chosen from a standard normal distribution around 408	

50% of the number of tokens on the input place. 409	

Deterministic: This moves exactly half of the tokens from input place to the output place 410	

each time a transition is fired. 411	

 412	
Normally we would use the standard normal distribution setting, as a halfway house between 413	

the other two modes of token flow. In some settings, the average result of simulations is similar 414	

with all these settings although variation between runs is greater with the more stochastic token 415	

flow settings, especially the uniform mode. However, when simulating feedback loops the mode 416	

of token flow can have a marked effect on the behaviour of such systems.  The mode you select 417	

may be based on which best models your system of interest.  418	

 419	

15. Selection of SPN simulation transition type. Token movement between places is via transition 420	

nodes which all operate using the same set of rules governing token flow. We have introduced 421	

two options, consumptive transitions and original transitions, which differ in how they operate with 422	

respect to token accumulation (Figure 3B5). Generally, we use the consumptive transition mode 423	

as this prevents the accumulation of tokens on entities where there is a constant input of tokens 424	

throughout the simulation but where flow through the target transition may be intermittent. 425	

 426	
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Consumptive Transitions: Tokens are consumed from place nodes irrespective of 427	

whether the transition is ‘open’ or not i.e. if there are two inputs into a transition and one 428	

has tokens and the other does not, tokens will still be lost from the input place with tokens 429	

as if flow were unrestricted. 430	

Original Transitions: Tokens accumulate on input nodes where flow from them is blocked 431	

i.e. if there are two inputs into a transition and one has tokens and the other does not, 432	

tokens will not be lost from the input with tokens. This mode was as originally described by 433	

Ruths et al.37. 434	

 435	

15. Run the simulation. Press the ‘Run the Simulation’ button to initiate the computation of the SPN 436	

algorithm (Figure 3B6).  437	

Critical Step. The time it takes to run a computation depends on the number of time blocks/runs, 438	

the size of the pathway model and hardware on which the simulation is run. However, for most 439	

small to medium size pathways (10’s-100’s of entity/process nodes) and hardware 440	

configurations, the time taken is usually a few seconds or less for a typical modern laptop. 441	

!Troubleshooting 442	

 443	

16. Save the results. Once the SPN simulation algorithm has finished, a Simulation Results dialogue 444	

appears (Figure 3C). Token level per node per time block results can be saved as a .txt or .spn 445	

file by ticking the “Save SPN Results” or pressing ALT+S (Figure 3C7). Saved simulation results 446	

files can be loaded pressing ALT+L in the main window. .spn result files can also be opened in 447	

programs such as Excel as a spreadsheet, or viewed and edited in a text editor. An mEPN 448	

model can also be exported as a Systems Biology Graphical Notation (SBGN)44 diagram via 449	

File -> Export -> SBGN file. This can be opened in any SBGN compliant software, e.g. VANTED 450	

with SBGN-ED add-on21.  451	
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17. Visualize token flow as node output graphs. To visualize the simulation results for a selected 452	

entity/place node, close the SPN simulation results dialogue (Figure 3C8), position the cursor 453	

over the node of interest and a pop-up window will appear showing the token flow associated 454	

with that node (Figure 3D). To view and compare token flow in multiple nodes, select the nodes 455	

of interest by pressing Shift+left mouse button and dragging the select window over the nodes 456	

of interest or by pressing the Shift+ALT+left mouse button to select multiple nodes. The 457	

corresponding flow graphs can be viewed using the Class Viewer by pressing CTRL+C (Figure 458	

3E) or the button with cog icon on left menu bar of the main window (Figure 3G).  459	

A range of options are available within BioLayout to adjust graph appearance. Shift+> or shift+< 460	

will increase or decrease node size, respectively; under the General tab you may turn on or off 461	

the visualisation of the compartments (yEd Graphml Container Rendering); and by pressing the 462	

‘Render Plot to File button’ on the top of the Class viewer window the graph can be saved as 463	

.jpg or .png image file (Figure 3E9).  464	

18.  Visualize token flow as an animation. Open the Simulation Animation Control window (ALT + 465	

A) when the simulation has finished (Figure 3F). Use options provided within BioLayout 466	

Express3D tool to control simulation visualization: 467	

Node Animation (Figure 3F10). Choose which nodes are animated (all, selected or pathway 468	

components only), and the type of animated transition that takes place between the node 469	

value associated with one time block and the next (discrete, linear, polynomial). 470	

Timing (Figure 3F11). Define how many time blocks per second are displayed and therefore 471	

the speed of the animation. If necessary also define which time block the animation begins 472	

from. 473	

Size Transition (Figure 3F12). Set maximum size of nodes during the visualization of token 474	

flow, i.e. when the number of tokens is at its maximum. The ‘Set (fixed) node value’ is the 475	

number of tokens on a node at which the maximum node size/colour is reached. The default 476	

value for the ‘Max value’ is determined by the maximum number of tokens that accumulates 477	
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on any node during a simulation. It is often the case that some nodes accumulate tokens 478	

much in excess of others, e.g. when their output is blocked. This can result in the majority of 479	

nodes seemingly to change little in size or colour during a simulation. Click on this value and 480	

add a value of your choice, and click on the associated check box, to maintain this value for 481	

subsequent runs. 482	

Colour Palette Spectrum Transition (Figure 3F13). A number of colour palettes are 483	

available, or one can be loaded by user, to colour nodes so as to reflect their token value. 484	

Select colour spectra from dropdown menu, load your own, or more normally, use default. 485	

 486	

19. Visualize token flow as an animation. Select ‘Start Animation’ (Figure 3F14) to watch tokens 487	

flow through your model (Figure 3G and Supplementary Video 1). 488	

!Troubleshooting 489	

 490	

Model optimisation, parameterisation and validation (timing: days to months) 491	

20. Check for errors. Errors in a diagram’s structure (predominately a failure to adhere to the strict 492	

requirement for a bipartite graph or improper logic), can lead to bottlenecks in token flow. When 493	

the bipartite graph structure is not maintained (e.g. an entity node is directly linked to another), 494	

tokens will accumulate on the node upstream of the issue and tokens are not passed 495	

downstream of the error. Check the reactions preceding any entity node whose token output is 496	

zero (Figure 4A) and correct mistakes. Place and transition spacer nodes are available to 497	

position between two nodes of the same type where the graphical description of events leads 498	

to this situation. Another common issue encountered is where the presence a pathway 499	

component is under the control of the system in which it operates. This can lead to a situation 500	

whereby for component to be synthesised it needs the pathway to be active, but the pathway is 501	

not active because it requires the activity of that component. In these circumstances it may be 502	

necessary to ‘prime’ the system adding tokens to the component in question prior to beginning 503	
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the simulation. Mistakes and errors in logic are easy to make, but equally easy to spot and rectify 504	

with this approach. It is normal practice to run a simulation, find out where the issues are, edit 505	

the model in yEd and rerun the simulation. There will likely be a need to repeat this process a 506	

number of times.  507	

 508	

21. End of the line. Without a downstream transition, a component at the end of a line of flow will 509	

simply accumulate tokens (Figure 4A). A final transition node is required to dissipate tokens 510	

from such entities. One option is to place a ‘pathway node’ at these points by dragging and 511	

dropping from the palette to allow indication of what happens next without showing it in detail. 512	

Alternatively, a ‘sink’ node can be placed as described above to signify that a component is 513	

removed from the system, e.g., the destruction of a protein by proteosomal degradation.  514	

 515	

23. Amplify or reduce token flow at specific sites. To simulate the amplification or reduction of a 516	

signal at specific sites in the network, add a numeric value to a transition-to-place edge. Select 517	

the edge, press [F6] and write a number in the Text field of the edge Properties dialogue. When 518	

a transition fires, the number of tokens produced on the downstream entity will correspond to 519	

the number of input tokens multiplied by the weight of the output edge, e.g., an edge weight of 520	

2 will result in a doubling in the number of input tokens, where as an edge weight of 0.5 will 521	

halve the number of tokens going forward. For example, one can amplify tokens as means to 522	

model the production of numerous protein molecules from a single transcript during protein 523	

translation (Figure 4C). 524	

 525	

24. Varying token input during a simulation. To simulate variation in the level of an input signal at 526	

different time blocks of a simulation, assign tokens to an input edge (as described in Step 9) 527	

using the following notation : a-b,c;d-e,f where ‘a-b’ defines the first and last time blocks that the 528	
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number of tokens ‘c’ will be added to the model and ‘d-e’ are the first and last time blocks that 529	

you would like the number of tokens ‘f’ to be added to the model. For example: 0-5,0;6-530	

15,100,16-20,0 translates into, add no tokens between time blocks 1-5, 100 tokens  between 531	

time blocks 6-15, and then remove token input until the end of the run, time block 20. Any 532	

number of these statements may be added to an input. This allows modelling of a system before 533	

and after a stimulus, or when a stimulus is transient or delayed. 534	

 535	

25. Validate the model by comparing it to experimental data. Once a model has been constructed, 536	

checked for structural errors and parameterised according to known variables, the first question 537	

is whether the model recapitulates the known activity of the system. For example, check if genes 538	

are expressed as transcriptomics data suggests, or does the flow of metabolic pathways under 539	

different conditions reflect what is known? The simulation of pathway dynamics should 540	

recapitulate the known activity of the system. If not, the obvious conclusion is the model is 541	

wrong. This could be because it is poorly constructed or parameterised, in which case the model 542	

needs improving. More interestingly, it could reflect the fact that there is part of the system that 543	

is as yet undiscovered. Once a model is working, i.e., it verifies the known characteristics of the 544	

pathway, it can be used to test known perturbations of the system e.g. the effect of knocking 545	

down/out a gene or inhibiting an enzyme. With confidence in a model’s characteristics it is then 546	

reasonable to use it to predict the effect of perturbing it, proving results that can be tested 547	

experimentally: one of the ultimate aims of dynamic modelling. 548	

 549	

	 	550	



22	
	

Troubleshooting	551	

Troubleshooting	information	can	be	found	in	Table	2	552	

	553	

Table	2:	Troubleshooting	table.	554	

Step	 Problem	 Possible	reason	 Solution	
1	 Information about a 

part of the pathway is 
unavailable.	

The experiments to 
elucidate the process 
have not been done.	

Use a ‘pathway 
module’ node to 
indicate that a process 
occurs but the details 
of which are undefined.	

12	 BioLayout Express3D 
fails to run. 	

Incompatible hardware 
or software 
configuration.	

Contact 
support@biolayout.org. 
Improve hardware 
specification.	

15	 ‘Error with Vertex 
weight!’ error popup is 
shown during 
simulation.	

Token input to node(s) 
is not readable by 
software.	

Check that token input 
is numerical (token 
input can be any 
positive number, 
including decimals) at 
all token input nodes.	

19	 Flow stops and 
downstream nodes do 
not accumulate tokens. 
 
 
 
 
 
Node accumulates 
tokens at linear rate.
  
 
 
Token flow occurs, but 
the size of nodes 
changes little.	

Bipartite graph 
structure has not been 
adhered to. 
 
 
 
 
 
Node has no output. 
 
 
 
 
The	maximum	token	
value	is	set	too	high.	

Identify bottleneck 
node by watching 
BioLayout flow 
animation. Return to 
yEd graph to edit 
model and rerun. 
 
 
Return to yEd graph to 
add sink node or other 
transition to node 
accumulating tokens. 
 
Open Animation 
Control window and 
lower value in ‘Set Max 
Value’ dialogue box.	

 555	

  556	
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Timing  557	

Steps 1 to 8, Information mining and pathway construction: Hours to months 558	

Steps 9 to 11, Conversion of the graphical model into a computable format: Minutes to hours 559	

Steps 12 to 19, Visualization of pathway and running simulations using BioLayout Express3D: 5 to 15 560	

minutes 561	

Steps 20 to 25, Model optimisation and parameterisation: Days to months  562	

 563	

Anticipated Results 564	

This protocol describes the generation of pathway models using the mEPN language for graphically 565	

representing biological systems. Graphical models can be used both as a resource to store and display 566	

what is known about a pathway and can be considered an end point in their own right, that can be updated 567	

or extended as new information becomes available. In addition, they can be converted to a computational 568	

model by setting parameters to define the initial state of the pathway. Using the sample interferon-β 569	

components GraphML file (Supplementary Data 2) a pathway model can be produced that represents 570	

events from the binding of interferon-β to its receptor and the signalling pathway leading the activation of 571	

target genes. The resulting model can be parameterised by adding tokens to obtain a simulation-ready 572	

model (Supplementary Video 1). This is a relatively small diagram; we also provide a model of the 573	

hedgehog signalling pathway as an example of a larger model (Supplementary Data 6). This was 574	

produced as part of a 10 week elective course by an undergraduate student with no previous modelling 575	

experience, indicating our modelling scheme can easily be performed by biologists with no prior 576	

modelling knowledge. Other pathway models are available at: www.virtuallyimmune.com.   577	

The BioLayout Express3D software is fully compatible with the mEPN notation and can be used for 578	

pathway visualization and to perform stochastic flow simulations using a modified version of SPN 579	
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algorithm37. Running simulations provides insights into the dynamic behaviour of the system by enabling 580	

users to visualize the signal flow within the network. The signal flow is simulated by the accumulation of 581	

tokens at entity nodes (places) and can be visualized in 2D graphs (as seen in Figure 4) or by 3D 582	

animation (as seen in Supplementary Video 1). The inflation and contraction of the entity nodes 583	

represents the accumulation and degradation of reactants in the pathway. In this way, complex biological 584	

processes with multiple components can be modelled. 585	

 586	

The interferon-β signalling network - a feedback control system 587	

Biological systems display a variety of dynamic behaviours ranging from stable steady states to oscillations. 588	

Oscillations in protein concentrations or gene expression levels are commonly associated with the presence 589	

of negative feedback loop(s) in the regulatory network45. Based on the analyses performed using this 590	

system many factors can affect the amplitude, frequency and stability of oscillations. For instance, the time-591	

delay (path length) between token input and inhibitor, the type of inhibition edge used (competitive or non-592	

competitive), the number of inhibitors present and their half-life, may all affect how a model containing a 593	

negative feedback loop will operate in practice. 594	

As an example, the simple model of the interferon-β signalling pathway is presented. Interferon-β is a 595	

cytokine released by immune cells in response to pathogens. It acts as an autocrine and paracrine 596	

signalling system that triggers the activation of host defence systems. In the provided model it operates as 597	

a damped oscillator46, where low-dose IFN stimulation yields oscillations of lesser amplitude that are 598	

damped faster than those induced at a high-dose (Figure 5). To reproduce these observations users can 599	

look at the different versions of IFN signalling feedback model provided in Supplementary Data 5 or modify 600	

the token input or topology of the Petri net examples provided in Supplementary Data 3. 601	

 602	

Contributions of the authors: A.L., L.O’H., M.E.P developed and wrote the protocol based on their 603	

experience in using the approach for modelling their own pathway systems of interest, T.A. developed a 604	

number of the features within BioLayout Express3D including SBGN export and refinement of the Petri net 605	
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algorithm, D.W. developed and has helped maintain the VirtuallyImmune.org website that is associated 606	

with this work, and L.B.S. helped with writing and editing the manuscript. T.C.F. has lead the development 607	

of the mEPN notation scheme and its use in modelling a variety of pathway systems; oversaw the 608	

implementation of model import into BioLayout Express3D; model visualisation within this tool, refactoring 609	

and refinement of the Petri net algorithm, and conceived of and assisted in writing the paper.  610	

 611	

Figure legends 612	

Figure 1. Workflow with steps described in the Procedure. 613	

Figure 2. Construction of a simple pathway model describing type-1 interferon signalling. (A) 614	

Components of the interferon-β signalling pathway drawn using mEPN notation (BOX 1). The information 615	

necessary to construct the interferon-β pathway has been highlighted in the pathway description: entity and 616	

transition nodes, edges and cellular compartments. (B) interferon-β pathway diagram assembled in yEd 617	

software using the pathway parts shown in A. (C) Parameterisation of interferon-β pathway by the addition 618	

of token inputs and a sink node output on SOCS1 inhibitor node (highlighted by red rectangles). Also shown 619	

is the edge properties dialogue in yEd where tokens can be added to an input edge. Model adapted from 620	

O’Hara et al., 2016	1. 621	

Figure 3. Visualization of token flow. (A) When a model is loaded into BioLayout Express3D it is displayed 622	

in a 3D environment using 3D equivalents to the 2D node glyphs as rendered in yEd. The software 623	

automatically recognizes a diagram as having been parameterised for computational modelling (based on 624	

the presence of process nodes as defined in the notation system) and prompts users to run a SPN 625	

simulation. (B) In the SPN Simulation dialogue users can set constraints on how to run the SPN simulation 626	

algorithm. (1) Defines the number of time blocks in a simulation; (2) Defines the number of runs in a 627	

simulation; (3) Calculates the variance in token flow between runs; (4) Defines the nature of the stochastic 628	

flow of tokens; (5) Defines the rules governing token flow through transitions; (6) Run the simulation. (C) 629	

SPN Simulation Results dialogue box summarises the simulation. (7) SPN results may be saved before the 630	

user chooses to (8) run the simulation again, close the dialogue box or proceed to animate the simulation. 631	
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(D) After a simulation has been run token accumulation at specific nodes can be visualised by placing the 632	

cursor over the node. (E) The flow of tokens across one or a number of selected nodes can be plotted using 633	

the Class Viewer showing plots of token flow over the time course of the experiment for selected nodes. 634	

The name and class of selected nodes is also displayed, and below are a range of options available for 635	

node selection and data export. (9) The token plot can be saved as a .png or .jpg image file. (F) Animation 636	

Control dialogue. (10) Options for the type of nodes to be animated and interpolation of flow between time 637	

bocks; (11) Speed of animation (time blocks per second); (12) Node size at maximum token number; (13) 638	

Colour palette selection to highlight change in token number; (14) Animation control: start, pause, step, 639	

stop. (G) BioLayout Express3D can produce animations of token flow through the model across time blocks. 640	

Node size will increase/decrease depending on the number of tokens passing through them and the colour 641	

of the node will also change according to a predefined spectrum of colours.  642	

Figure 4. Influencing token flow along a linear pathway. Figure shows the flow of tokens through a small 643	

linear pathway motif depicting a gene being transcribed into mRNA, which is then translated into the 644	

encoded protein. Addition of a sink node represents the protein’s degradation. (A)  Blocked flow. Top of the 645	

three illustrations all is as described above, and over the 20 time blocks of the simulation there is an initial 646	

rise in the level of the protein followed by a steady-state, as the number of tokens entering the entity node 647	

matches those leaving through the sink i.e. the rate of production of the protein matches the rate of its 648	

degradation (blue line). Failure to maintain bipartite graph structure (shown here by connecting two entity 649	

nodes for mRNA and protein without a process node between them) causes tokens to accumulate on the 650	

first entity node (mRNA) and not pass to the second (protein), which stays at zero tokens throughout the 651	

simulation (pink line). In the absence of a sink node, tokens to accumulate on the protein node (green line). 652	

(B) Modelling time. The diagrams show the effect of increasing the length of linear networks on the rate of 653	

token accumulation. Input tokens are introduced into each of the networks at the same time but the protein 654	

accumulates at different rates. The delay is proportional to the number of transition steps introduced in the 655	

network and such delay motifs may be added where a transition nodes represents a multistep process such 656	

as transcription or translation.  (C) Amplifying or depleting signal. The addition of a value to the edge leaving 657	

a transition can be used increase (pink line) or decrease (green line) downstream token flow. In this way 658	

one might model one mRNA molecule leading to production of multiple protein molecules, or the inefficient 659	
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translation of mRNA where only a single protein molecule is produced from multiple mRNAs. Simulation 660	

options in A, B and C: 100 tokens, 100 runs, 20 time blocks, Normal Standard distribution and with standard 661	

deviation of token flow between runs shown. 662	

Figure 5: Effect of parameterisation on activity of feedback loop. (A) A simple pathway model 663	

representing the type-1 interferon signalling pathway constructed and parameterized in yED using mEPN. 664	

Graphs show token accumulation on the activated transcription complex ISGF3 (circled in red) following 665	

simulations with (B) 1000 input tokens (blue line) or 100 input tokens (green line) added to interferon-β with 666	

SOCS1 acting as a non-competitive inhibitor or (C) as a competitive inhibitor of the activated receptor 667	

(dashed red edges). (D) Oscillatory activity of the SOCS1 feedback loop with (magenta line) or without 668	

(blue line) a delay introduced between the transcription and translation of SOCS1 (dashed black edges), 669	

again with SOCS1 acting as a non-competitive or (E) competitive inhibitor of the activated receptor. 670	

Simulation options: 100 runs, 500 time blocks, Normal Standard distribution and with standard deviation of 671	

token flow between runs shown. 672	

 673	

  674	
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Supplementary Files 675	

Supplementary Data 1.  mEPN palette for loading within yEd software. This is a graphml file containing all 676	

the different types of entity nodes to represent the different classes of molecules that might play a part in a 677	

pathway, as well as the process nodes that represent different types of interactions. This file can be loaded 678	

into yEd to provide a palette of mEPN nodes for pathway construction (see step 4 of the procedure). 679	

Supplementary Data 2.  Interferon-β signalling pathway components. This is a graphml file containing all 680	

the different parts of the simple model shown in figure 2B, to allow practicing model construction. Try 681	

assembling the model using only the text below: ‘Interferon B (IFNB1) is a cytokine released from many cell 682	

types in response to immune stimulation. It homodimerises and binds to its cell surface receptor complex 683	

composed of the receptor proteins IFNAR1 and IFNAR2 and the intracellular kinases TYK2 and JAK1.  The 684	

complex is composed of 2 of each of these proteins. Binding causes a conformation change in the complex 685	

resulting in the autophosphorylation of JAK1. Once activated, the complex catalyses the phosphorylation 686	

of STAT2 which forms a heterodimer with STAT1. This complex then binds interferon regulatory factor 9 687	

(IRF9), forming the complex often referred to as ISGF3, and translocates to the nucleus.  Here it binds to 688	

the IRF sequence in the promotor of a number of genes including MX1, MX2, IFIT1, IFITM3, TAP1, OAS1, 689	

GBP1, PSMB9, SOCS1. In turn SOCS1 inhibits the autophosphorylation of the receptor thereby inhibiting 690	

further activation.’  691	

Supplementary Data 3.  Primary network motifs drawn in Petri net style for testing SPN algorithm. This is 692	

a graphml file containing a series of different network motifs and parameterisations potentially found in 693	

pathway diagrams. This includes linear networks, multiple inputs/outputs to transitions and nodes, and a 694	

series of models representing a range of feedback loops with varying path lengths between token input and 695	

inhibition, inhibition type (competitive vs. non-competitive), and one or multiple feedback inhibitors. The file 696	

is designed to allow you to explore the different interaction types and algorithm settings when setting up a 697	

simulation run. Certain nodes are coloured such that when a simulation has been run within BioLayout, 698	

these nodes may be selected and you can compare results across motifs. 699	
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Supplementary Data 4.  Interferon-β signalling pathway. This is a graphml file of the simple model shown 700	

in figure 2B.   701	

Supplementary Data 5.  Changing parameters - Interferon-β signalling pathway. This is a graphml file 702	

containing six versions of the model shown figure 2B (Supplementary Data 4), each version is 703	

parameterised slightly differently, with variation in: type of inhibition (competitive vs. non-competitive); 704	

introduction of a delay between SOCs1 expression and protein; and an amplification of signal between 705	

gene and mRNA.   706	

Supplementary Data 6.  Example of a more complex model - Hedgehog signalling pathway. This model 707	

(given here as graphml file) is a representation of Hedgehog signalling from the binding at its receptor, 708	

activation of the GLI protein on the tip of the primary cilium through the activation of various downstream 709	

pathways (not shown in detail). It contains 550 nodes and 601 edges and was assembled using pathway 710	

resources such as Reactome22 and the primary literature. Its parameterisation, in terms of token placement 711	

is arbitrary.  712	

 713	

Supplementary Video 1. Movie of the interferon-β signalling pathway (Supplementary Data 4) simulation 714	

run within BioLayout. The movie shows the process of model loading, running the simulation, inspecting 715	

token accumulation on specific components and watching the flow of tokens run through the model as an 716	

animation. 717	

 718	

 719	

 720	

 721	

  722	
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BOX 1: mEPN Notation 2017 723	

The modified Edinburgh Pathway Notation (mEPN) scheme3 is a graphical notation system based on the 724	

concepts of the process diagram4, below the glyph library is shown in its current form (reproduced from 725	

O’Hara et al.	1). 726	

 727	

 728	

Pathway components 729	

Types of pathway information. The information depicted in a pathway diagram drawn using the mEPN 730	

scheme may be divided into the following categories: 731	
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• Entity: any component involved in a pathway, e.g. protein, protein complex, nucleic acid sequence 732	

(promoter, gene, RNA), simple biochemical, drug etc., and depicted as an ‘entity node’. Different 733	

shaped nodes are used to represent different types of components. The mEPN scheme consists 734	

of twelve different entity nodes (detailed in the top left panel). Also included are a Boolean logic 735	

‘OR’ operator node and spacer node (represented as a white circle with a black border) that may 736	

be required to maintain bipartite pathway arrangement. Entity nodes function as the equivalent of 737	

Petri net ‘places’ and all entity nodes are equivalent in Petri net simulations 738	

• Process: an interaction that occurs between pathway components, where one component interacts 739	

with or influences the state of another through its binding, inhibition, catalytic conversion, etc., is 740	

depicted as a process node. Processes are generally depicted as a circular node with a 1-3 letter 741	

code to indicate the type of process, e.g., P = phosphorylation, B = binds, X =cleavage etc. Included 742	

in the scheme are 38 different process nodes (top central panel). Additional to these, but also acting 743	

as transitions, are a sink node which is placed at the end of pathway and represents removal of a 744	

component from the system; a pathway module node that summarises not one process but a series 745	

of events; a Boolean logic ‘AND’ operator node; token input nodes that are placed at the start of a 746	

pathway and oriented either horizontally or vertically to fit in with the pathway layout; a spacer node 747	

represented as a black diamond. A larger version of this node can also be used as a distribution 748	

node when multiple edges exit from an entity node. Process nodes function as the equivalent of 749	

Petri net ‘transitions’ and all process nodes are equivalent in Petri net simulations. 750	

• Interaction: a directional edge that links an entity node to a process node or vice versa that indicates 751	

direction and the nature of the interaction. There are six possible connecting edges (bottom central 752	

panel) that represent the nature of the interaction between nodes. The first three (interaction, 753	

catalysis and action potential) operate identically within a Petri net and serve to carry tokens 754	

between entity and process nodes. The two inhibitor edges act to inhibit the flow of tokens through 755	

target process nodes albeit based upon different rules. The non-competitive inhibitor edge 756	

completely blocks token flow through the target transmission if any tokens are present on the 757	

inhibitor node. In contrast the competitive inhibitor edge works by deducting the number of tokens 758	

residing on the inhibitor away from the number of tokens flowing through the target transition. 759	
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Finally, the non-covalent interaction edge can be used to depict two separate entities within a 760	

complex. This may be a useful when describing large complexes, but these edges do not operate 761	

within the context of a Petri net simulation.  762	

• Cellular compartment: define where pathway components reside and interactions take place, such 763	

as an organelle (e.g. mitochondrion, nucleus) or a transient cellular compartment (e.g. vesicle). In 764	

the diagrams they are shown as large coloured nodes that sit behind the interaction model (right 765	

panel). 766	

End of Box 1 767	

 768	

  769	
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BOX 2: Petri nets to model biological systems 770	

Petri nets (panel A) are a mathematical approach for describing distributed systems and have been used 771	

extensively in the modelling of many different kinds of systems including biological pathways. There are 772	

numerous types of Petri net algorithms and software that support modelling using them. The Petri net 773	

algorithm employed here was first developed and described by Ruths el al.37,	 a modification of a 774	

synchronized Petri net model and firing policy, they called the signalling Petri net (SPN). Petri nets share a 775	

number of common features. Models are constructed as directional bipartite networks where nodes are 776	

considered to be either ‘places’ or ‘transitions’ connected by ‘arcs’. Places usually represent an entity or 777	

state and by convention are represented as a white circle. Transitions represent interactions between 778	

entities or the transition of an entity from one state to another and are usually represented as a black 779	

rectangle. Arcs are directional arrows that connect places to transitions and vice versa. The availability of 780	

an entity and its abundance can be represented by the initial placement of tokens. The flow of information 781	

through the network is represented using tokens that move between places through transitions, following 782	

in the direction of the arcs. In the context of biological pathways paces represent pathway components, 783	

transitions correspond to processes that modify the components in some way, such as phosphorylation, 784	

binding etc., and are referred to as ‘process nodes’. The interactions between molecules are depicted by 785	

edges, equivalent to arcs in Petri net parlance. Panel B shows how the notation for representing pathways 786	

using mEPN map on to Petri nets. 787	
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 788	

Rules determining token flow through transitions. Activity flow is represented by the movement of 789	

tokens between places. The state of each place (component) is determined by the number of tokens held 790	

by it. When a transition is fired, tokens are moved from each input place and redistributed downstream, the 791	

transition acting as rule-based controller of flow. A transition will pass on tokens only if all the input places 792	

contain tokens and where one input has less tokens than others, the passage of tokens will be governed 793	

by the input place holding the least number of tokens. In the case of the Petri net algorithm employed here, 794	

the movement of tokens is also stochastic.  This is because during a time block all transitions in a model 795	

are fired once but in a random order, and the number of tokens taken forward when a transition is fired will 796	

be a random number between zero and the maximum available (although we have implemented other 797	

versions of this rule, see step 13). Due to the stochastic nature of token flow, a simulation usually comprises 798	

of a number of runs, the answer being based on the average token flow across runs. Furthermore, when a 799	

transition is fired the number of tokens moved forward through the transition will be subtracted from the 800	

amount available on the input places. One innovation not found in most other Petri net simulators, is our 801	

implementation of a consumptive transition mode. When running in this mode (for us this is standard), a 802	

constant input of tokens is applied to an entity node throughout a simulation, but token levels on the node 803	

remain constant (unless others are fed in from another source), as tokens are lost from it at the same rate 804	
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they are added even when there is no flow through the target transition. In this way places representing 805	

entities such as enzymes (or indeed any other molecule) can receive a constant input of tokens throughout 806	

a simulation without accumulating or losing tokens.  807	

Modelling time. Time in Petri nets is measured in abstract units called time blocks. When constructing a 808	

model, it is useful to consider how many experimental seconds, minutes, or hours correspond to a time 809	

block. Timing depends on the network topology and the further away a node is from the start of flow the 810	

longer it will take tokens to reach it. To simulate such time delays users can create a linear network that 811	

alternates transitions with spacer nodes multiple times. When tokens are passed through such a linear 812	

network the number of output tokens corresponds to the input but the time taken for tokens to reach the 813	

end is proportional to the number of spacer nodes (Figure 4B). 814	

	End of Box 2 815	

 816	

 817	

 818	

  819	
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BOX 3: Component Annotation 820	

Multiple names are frequently employed to describe molecular species.  This is particularly the case for one 821	

of the main components of biological pathways: proteins. Any given protein may be referred to in the 822	

literature by a number of different names concurrently. The use of non-standard nomenclature frequently 823	

leads to confusion in written texts and diagrams. If the naming of pathway components is not clear, then 824	

uncertainty arises as to what exactly is being depicted in a diagram and it ends up representing little more 825	

than a series of abstract concepts.  826	

Our models have generally been focused on human pathways and we have used standard Human Gene 827	

Nomenclature Committee (HGNC) names to label nodes representing genes and proteins 828	

(www.genenames.org). This and related nomenclature systems such as the Mouse Genome Database 829	

(MGD) standard (http://www.informatics.jax.org/mgihome/nomen/), now provide a near complete 830	

annotation of all human and mouse genes, and their use in the naming of proteins provides a direct link 831	

between the identity of the gene and the corresponding protein. Of course, not everyone has adopted these 832	

naming systems so where other names (aliases) are in common use, these names are often included as 833	

part of the node’s label after the official gene symbol in rounded brackets, but generally only on its first 834	

appearance in the pathway. Use of standard nomenclature also assists in the comparison and overlay of 835	

experimental data (which is usually annotated using standard gene nomenclature) onto pathway models. 836	

At the present time there are no standard and universally recognized nomenclature systems available for 837	

naming certain types of pathway components. For instance, protein isoforms tend to be named in an ad 838	

hoc manner by those who study them, and biochemical compounds are known by both their common 839	

names or by names that reflect their chemical composition. The IUPAC (www.iupac.org/) provides a 840	

standard nomenclature system for organic chemicals, but most names would have little relevance to a 841	

biologist. In cases such as these, the important thing is to be consistent and, where possible, to cross-842	

reference the component’s ID to other sources such that the identity of the component depicted, where at 843	

all possible, is unambiguous. We have used the excellent ChemSpider resource (www.chemspider.com/) 844	

as a reference for the naming of biochemical entities, although other resources, e.g., ChEMBL 845	

(www.ebi.ac.uk/chembl/) are potentially equally good. Using the node properties dialogue [F6], nodes may 846	
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be hyperlinked to external web resources and additional notes to nodes can be added using in the Data tab 847	

within yEd. 848	

 849	

Protein state: The particular ‘state’ of an individual protein may determine its functional activity. With 850	

mEPN, a component’s state is indicated as a text addition to the node label using square brackets following 851	

the component’s name; each modification being placed in separate brackets. The system can be used to 852	

describe a wide range of protein modifications like phosphorylation [P], acetylation [Ac], ubiquitination [Ub] 853	

etc., and where details of the site of modification are known this may be represented, e.g., [P@L232] = 854	

phosphorylation at leucine 232.  855	

 856	

Protein complexes: Names of the components are given as a concatenation of the proteins belonging to 857	

the complex, separated by a colon. If a complex is commonly referred to by a generic name this may be 858	

shown below the constituent parts in rounded brackets. Where a specific protein is present multiple times 859	

within a complex, this may be represented by placing the number of times the protein is present within the 860	

complex in angle brackets i.e., <n>. A node representing a component may be coloured to impart visual 861	

information on the component’s type, e.g. to differentiate between a protein and a complex. Similarly, other 862	

types of pathway components may be represented using a range of shapes and colours – see palette (BOX 863	

1, downloadable as Supplementary Data 1) for list of glyphs used to represent different entity types. A 864	

component may only be shown once in any given cellular compartment (in a given state). A component 865	

may however alter from one state to another, e.g., inactive to active, unbound to bound, in which case both 866	

forms are represented as separate entities. A different state may be indicated by including the name in 867	

square brackets, as described above. 868	

 869	

End of Box 3 870	

 871	

  872	
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BOX 4: Layout Optimisation 873	

There is a part of pathway modelling that could be considered art, or at least creative cartography. When 874	

starting a diagram the number of components is small, and visual comprehension of the system of nodes 875	

and edges is relatively easy. However, this situation soon changes as a diagram grows, and one of the 876	

greatest challenges is to render the inherently complex connections between components of a network 877	

model in a human readable form. This necessitates the careful placement of nodes and edges in the 878	

network layout. There are large number of layout algorithms available for network visualization but 879	

unfortunately none come close to the results achievable by a skilled human curator. Certain rules can be 880	

applied to this process to aid readability of the model: 881	

• Models should be constructed, where possible, along a horizontal or vertical axis, arranged top down 882	

or left to right in the direction of information flow. 883	

• Nodes should be evenly spaced and aligned along the chosen axis of layout but within the cellular 884	

compartment in which they reside. 885	

• Crossing over of edges should be kept to a minimum and changes in edges direction should be avoided 886	

when possible. When multiple edges run parallel to each other it is important to keep the lines straight 887	

to maintain an easy-to-follow diagram. 888	

• Space can be organised effectively by structuring sub-pathways into modules. 889	

• Modules of the pathway should be arranged so that the connected glyphs are in close proximity, to 890	

minimise overlapping of connective edges. 891	

• Hierarchical relationships between components should be shown in the layout of interactions. To do 892	

this, an orientation of pathway flow is chosen (e.g. left to right or top to bottom) and should be 893	

maintained throughout the diagram where possible.  894	

However, each diagram is essentially unique and each comes with its own challenges. There is no one 895	

solution that fits all models so the layout of the diagram must be able to be easily adapted to take in new 896	

components and concepts whilst maintaining its readability.  897	

 898	

End of Box 4 899	

900	
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BOX 5: Glossary  901	

• Arc: By convention in Petri net parlance, arcs are the directional edges that connect a place to a 902	

transition or vice versa, (but never between places or between transitions). Arcs are referred to as 903	

edges in mEPN.  904	

• Edge: In mEPN notation, edge is used to refer to any line used to connect entity and process 905	

nodes to indicate an interaction (activating or inhibitory), and also the direction of that interaction. 906	

The Petri net equivalent is an arc.  907	

• Entity node: Entity nodes are glyphs that represent pathway components such as molecules or 908	

genes. The Petri net equivalent is a place. 909	

• Glyph: a visual representation of an entity, process or transition node. 910	

• GraphML: a XML-based file format used to describe the structural and visual properties of a model.  911	

• Layout: the way in which nodes and edges are set out in 2D or 3D space (physical topology). 912	

• Model: the visual representation of a network.  913	

• mEPN: modified Edinburgh Pathway Notation scheme is a graphical notation system based on 914	

the concepts of the process diagram.  915	

• Network: a number of nodes connected by edges. 916	

• Notation scheme: a system of symbols used to represent biological entities and interactions 917	

between them in a semantically and visually unambiguous manner. 918	

• Parameterization: defining the initial state of the system through the placement of tokens. 919	

• Petri net: a directed bipartite graph that alternates places (entities) and transitions (events that 920	

occur). 921	

• Place: In Petri nets, places represent possible states of the system. They are referred to as 922	

entity nodes in mEPN notation. 923	

• Process diagram: a diagram used to formally describe the components of a system, their 924	

activation state and the interactions between them. 925	

• Process node: In mEPN notation, process nodes are glyphs that represent and define 926	

interactions between entities or the transition of an entity from one state to another. The Petri net 927	

equivalent is a transition. 928	
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• SPN: Signalling Petri Net as defined by Ruths et al 37. Please note, in the context of Petri nets 929	

SPN is also often used to refer to Stochastic Petri Nets, a class of Petri net algorithms used to 930	

model the stochastic flow of tokens, as in the case here. 931	

• Tokens: Tokens represent quantitative information that is introduced and distributed through a 932	

Petri net. Here they can be thought of representing the amount and/or activity of a pathway 933	

component. 934	

• Topology: arrangement of various elements of the pathway (nodes, edges, etc.) that illustrates 935	

how information flows within the network.  936	

• Transition: In Petri nets, transitions are events or actions. They are represented as process 937	

nodes in mEPN notation. 938	

 939	

End of Box 5 940	

 941	

  942	
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Table 1: A list of resources useful for the compilation of pathway diagrams  959	

Literature Databases  

NCBI Pubmed http://www.ncbi.nlm.nih.gov/pubmed/ 

Web of Science http://wok.mimas.ac.uk/ 

Google Scholar http://scholar.google.co.uk/ 

Scopus http://www.scopus.com/ 

iHop http://www.ihop-net.org/ 

Component Annotation  

NCBI Entrez Gene http://www.ncbi.nlm.nih.gov/sites/entrez 

Gene Cards http://www.genecards.org/  
Gene Ontology http://www.geneontology.org/GO.downloads.annotations.shtml  

PubChem http://pubchem.ncbi.nlm.nih.gov/  
Chemspider http://www.chemspider.com 

Interaction Databases  

ConsensusPathDB http://cpdb.molgen.mpg.de/  

BioGRID http://thebiogrid.org/  

IntAct http://www.ebi.ac.uk/intact/  

GeneMANIA http://www.genemania.org/  

Human Protein Reference 

Database 
http://www.hprd.org/index_html  

MINT http://mint.bio.uniroma2.it/mint/Welcome.do  

STRING http://string-db.org/  

DIP http://dip.doe-mbi.ucla.edu/dip/Main.cgi  

MIPS CORUM http://mips.helmholtz-muenchen.de/genre/proj/corum  
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Pathway Repositories  

KEGG http://www.genome.jp/kegg/  
Reactome http://www.reactome.org/  

Biocarta http://www.biocarta.com/genes/index.asp  

WikiPathways http://wikipathways.org/index.php/WikiPathways  

 960	

  961	
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